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SnagIt

Overview

SnagIt is the print utility that
Microsoft Windows forgot. SnagIt is a
screen print and capture program for
Windows. With SnagIt, you can:

o Capture screens, windows, and icons
and send them to your printer, the
clipboard, or a write them out to a
file.

o Cut and paste captured images into
word processors or desktop publishing
programs.

o Perform color enhancement, color to
monochrome conversion or gray scaling

Potential users:

o Developers will want to use SnagIt to
print program screens, and windows.

o Documentation writers can use SnagIt
to import screens and windows into
manuals, marketing literature, and
other documents.

o Advanced users can use Dynamic Data
Exchange (DDE) to control SnagIt's
printing functions from other Windows
applications.
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TechSmith Corporation Overview

The TechSmith Corporation is a
computer consulting and software
development company located in Okemos,
Michigan. We provide a full range of
services to organizations assessing or
implementing Windows or OS/2
applications for use in distributed
systems. We concentrate our services on
those areas that are most likely to
complement the capabilities within our
customer's organizations. We offer
assistance during the assessment and
design and development phases. We offer
an extensive background in the
successful implementation of distributed
applications on Windows and OS/2
platforms. Our experience includes
projects using all major network
topologies, protocols, LAN operating
systems, and many LAN-based commercial
products.

3



Table of Contents

Introduction .....................4

Installation .....................5

Getting Started ..................6

Feature Reference
Mouse Controls.................9
Input..........................9
Output........................11
Format........................12
Options.......................13
Save Setup....................14

Advanced Topics
Monochrome Conversion.........15
Color Boost...................16
Gray Scaling..................16
DDE Usage.....................16

Appendix A
DDE Command Reference.........17

Appendix B
Other Products................19

4



Introduction

This manual is divided into three
sections.

The first section contains:

o Installation instructions.

o Getting Started, directions on how to
create basic screen prints with
SnagIt.

The second section, Feature Reference,
contains:

o Snagit menus

o Explanations each of the options and
its use.

The third section, Advanced Topics,
contains:

o Discussions on how to use the
advanced features of SnagIt such as,
color boost, and gray scaling and
using Dynamic Data Exchange.

o Dynamic Data Exchange features.

This document was created using SnagIt
and Microsoft Word for Windows
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Installation

o System Requirements:

Microsoft Windows 3.0
. printer that supports Bitmaps

such as an HP Laserjet or a
Postscript Printer

o Installation Steps

1. Copy the file SNAGIT.EXE
to your windows directory.

Example:
COPY A:SNAGIT.EXE C:\WINDOWS

2. Start Windows.

3. Select the Accessories
Group.

4. Create a new program item
for SnagIt with the Program
Manager. (Consult your Windows
Users Manual if you need help with
this operation.)

o To load SnagIt automatically each
time you start Windows:

1. dit your WIN.INI file in
the windows directory

2. dd SNAGIT to the load
line.

Example:
Load=CLOCK, SNAGIT
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This will load the Clock and SnagIt
as icons.
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Getting Started
Printing a Screen

In this section you will:
o Learn how to use some of the

basic features of SnagIt
o Create your first screen print

Loading SnagIt

1. Start Windows.

2. If you configured your WIN.INI to load
SnagIt automatically, you will
see the SnagIt icon displayed
at the bottom of your screen.

3. If SnagIt has not been automatically
loaded, activate SnagIt by double
clicking on the SnagIt icon in the
Accessories Group.

Selecting the Print Area

SnagIt can print the entire screen, a
selected region of the screen or a
single window. Select the print option,
by first double clicking on the SnagIt
icon to restore SnagIt to a window.
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SnagIt Restored to a Window

The SnagIt window will display the
current settings. Click on the Input
menu item to view the list of options.
Select one of the following options:

Screen: Prints the entire
screen.

Entire Prints a single window.
Window:

Client Area: Prints only the window
client area.

Region: Allows you to select a
rectangular region
anywhere on the screen.

If you selected Entire Window, Window
Client Area or Region from the Input
menu, SnagIt will ask you to pick a
window or region when you print.

Printing
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To print press [Ctrl][Shift]P.

Your mouse pointer will change to a
pointing finger for selecting a window
or to scissors for selecting a region.

If you selected Entire Window or Window
Client Area as the input area, position
the pointer on the title bar of the
window you wish to print and press the
left mouse button.

If you selected Region as the input area
position the pointer at the upper left
corner of the region you wish to print.
Hold down the left mouse button and drag
the pointer to the lower right corner of
the region and release the mouse button.

You can cancel the selection process by
clicking the right mouse button.

While SnagIt is printing the following
message box will be displayed.

To cancel the printing operation, click
on the Cancel button in the message box.
The portion of the image already sent to
the printer will print.
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Feature Reference
Mouse Controls

Left Button - The left mouse button
is used to select SnagIt menu
options and to select screen
images.

Right Button - The right mouse
button is used to cancel a
selection operation.

Keyboard Controls

[Ctrl][Shift]P - Activates SnagIt

Input

SnagIt Input Menu

The Input menu is used to select the
image type that SnagIt will print. The
currently selected option is marked by a
check mark. The different input options
work as follows:
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Screen - Select Screen to print the
entire screen.

Window Client Area - Select this
option to print only the client
area of a single window. The
client area is the area surrounded
by the window borders. The client
area does not include the borders,
title bar, scroll bars or the
caption line.

After you press [Ctrl][Shift]P,
select the client area you want to
print by positioning pointer
anywhere in the client area then
clicking the left mouse button.

Entire Window - Select this option
to print an entire window.

After you press [Ctrl][Shift]P,
select the window to print by
positioning the pointer over the
title bar then clicking the left
mouse button.

Note: Always select the window you
want to print by clicking on the
title bar. Items within a window,
such as OK and Cancel buttons, are
actually small windows. Icons are
considered windows as well.
Clicking on one of these items will
result in that item printing, not
the entire window.

Region - Select this option to
print a rectangular region of the
screen.
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After pressing [Ctrl][Shift]P,
select a region by positioning the
pointer over the upper left corner
of the region. Press and hold the
left mouse button. Then drag the
pointer to the lower right hand
corner of the region and release
the mouse button.

Bitmap File - Select this option
to print an image stored in a
bitmap file.

When you press [Ctrl][Shift]P,
SnagIt will display a dialog box
requesting the file name.

Bitmap files are graphics files
generated by some paint programs,
SnagIt or other Windows programs.
Bitmap files have a file extension
of .BMP.

Clipboard - Select the clipboard
option to print the contents of the
Windows clipboard. Items are
placed on the clipboard by using
SnagIt or the cut and copy commands
in other Windows programs.
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Output

SnagIt Output Menu

The Output menu is used to select the
output device for the images captured by
SnagIt. SnagIt supports the following
output devices:

Printer - Select Printer to send
the output to the currently
selected Windows printer.

Bitmap File - Select BMP File to
write the captured image to a BMP file.

After you select an input image
SnagIt displays a dialog box asking
for a file name.

TIFF File - Select TIF Mono File to
write the captured image to a TIFF file.
After you select an input image
SnagIt displays a dialog box asking
for a file name.

Clipboard - Select Clipboard to
send the input image to the Windows
Clipboard.
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Format

SnagIt Format Menu

SnagIt supports three different format
options: Mono-chrome, Color, and Gray
Scale. Select the format option with
the Format Menu. The currently selected
option is identified by a check mark.
The format options work as follows:

Monochrome - The input image is
converted to monochrome before it
is sent to the output device. The
intensity threshold level
determines the amount of black and
white that will appear in the
output image.

When you select Monochrome, the
following dialog box is displayed
for setting the Intensity
Threshold.
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Intensity Threshold Dialog Box

Color - All color information for
the selected image is sent to the
output device.

Gray Scale - When Gray Scale is
selected, colors are represented by
up to 256 shades of gray.

Note: Gray scaling large images may
take a while to complete.

See the Advanced Topics Section for
further discussion on formatting
options.

Options
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SnagIt Options Menu

Alert - Set the alert options to have
SnagIt signal you with a beep(s) when it
has completed processing. There is an
alert option for both input and output
processing. The values entered for
these fields determine the number of
beeps. This feature is particularly
useful when using the gray scale option.

Clipboard Chain - Clipboard Chain - Setting the clipboard
chain option causes SnagIt to print each
time the clipboard changes.

Clipboard chaining is useful for doing a
print screen from a DOS session. When
you press the Print Scrn key in a DOS
box, Windows copies the screen to the
clipboard. If you have the clipboard
chain option set, SnagIt automatically
copies the image to the printer for you.

Note: To select Clipboard Chain, the
input device must be set to Clipboard,
and output device must be set to
Printer.
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Color Boost - Color boost is used to
adjust the color intensities for Red,
Green, and Blue. When Color Boost is
selected, a dialog box is displayed for
color boost values.

Color Boost Dialog Box

You may control the intensity for each
pixel two ways:

1. Add or subtract intensity levels
(hue) for each color range by
entering a value from -255 to 255.

2. Increase or decrease intensity
levels by a percentage (saturation)
by using the slider bar.

The default value for each additive
range is zero and the percentage
bar is 100%.
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To activate color boost, click on the
"Use Color Boost" check box. Color
boosting, if enabled, is applied to the
input image before it is sent to the
output device. For further discussion
on the use of color boost, see the
Advanced Topics Section.

Scale - This option allows you to enter
an integer scaling factor to be applied
to the input image. A scaling factor of
2 will double the size of the input
image.

Save Setup

SnagIt can save all of the currently
selected options. The Save Setup option
is located under the system menu. The
system menu is accessed by pressing Alt
Space or by clicking on the minus sign
in the upper left corner of the SnagIt
window. When you save the setup, SnagIt
writes all of the current settings to
your WIN.INI file. SnagIt will read the
saved setup each time it is loaded
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Advanced Topics

Monochrome Conversion

When Windows converts a color image to
monochrome, it converts the background
color to white. All other colors are
converted to black. This usually
results in a most of the image getting
converted to black. SnagIt uses an
intensity threshold to control the level
of black and white resulting from the
conversion process.

SnagIt looks at the intensity level of
each pixel and converts higher
intensities (lighter colors) to white
and lower intensities (darker colors)
to black. This conversion process
usually results in a more even balance
of black and white in the output image.
The amounts of black and white are
controlled by adjusting the Intensity
Threshold value under the Monochrome
setting of the Format Menu. You may
also use the color boost values to
adjust color intensities before
conversion to monochrome.

You will get different results
converting images to monochrome if you
use the Windows Setup program to
configure Windows for a monochrome
monitor. You may need your Windows
diskettes the first time you do this.

When configured for a monochrome
monitor, Windows creates grays as
patterns of black and white dots
(dithering), which will print on a
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monochrome device such as a laser
printer.
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Color Boost

Color boost is used to change the
intensity of the colors. Increasing the
boost value lightens the output. Color
boost is performed before gray scaling
or monochrome conversion, therefore it
can be used to lighten or darken the
output with those options as well.

Gray Scaling

Gray scaling is an alternative to
monochrome conversion. SnagIt can
represent colors with 256 levels of
gray. The shades of gray are determined
by the intensity level of the colors.
You can adjust the color intensity
levels with the Color Boost option under
the Options Menu.
Caution: Gray scaling is a pixel by
pixel process and can be very slow. It
is a good idea to try a small region
before printing the whole screen. You
may also want to enable the Alert
feature under the Options Menu to let
you know when the gray scaling process
is completed.

Dynamic Data Exchange Usage

SnagIt supports Windows Dynamic Data
Exchange (DDE). You can invoke SnagIt
from other Windows programs by sending
SnagIt DDE Messages. For Example, you
can print write an Excel macro that will
print a portion of the screen using
SnagIt. See Appendix A for the DDE
command reference.
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Appendix A - Dynamic Data Exchange
Reference

Initiating a DDE Session

To initiate a DDE session with SnagIt,
send a DDE_INITIATE with the application
parameter of "SnagIt" and the topic
parameter of "system".

Setting SnagIt Options

All of the SnagIt Menu options can be
set using the DDE_EXECUTE command.

Example

[set ("string")]

The parameter string must be one of the
following:

input screen
input client
input window
input region
input file
input clipboard
scale best
scale screen
scale n (where n is an integer >

0)
output printer
output file
output clipboard
chain b (where b is

1,True,Yes,0,False, or No)
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boost red,green,blue (integer
value 0..1000)

add red, green, blue (integer
value -255..255)

inalert n (where n is the number of
beeps)

outalert n

Activating SnagIt

SnagIt is activated by sending a
DDE_EXECUTE command with the message:

[snag("string")]

The string parameter can be one of the
following:

snag (activates menus selected
input)

screen
clipboard
filename
x y (where x,y are coordinates

within a window)
client x y
handle h (where h is a valid

window handle)
client handle h
tx ty bx by (where tx,ty,bx,by
are coordinates defining a region)
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Appendix B - Other TechSmith Products

Other Software Available from TechSmith.

DDEWatch

DDEWatch is a Windows DDE monitoring
utility. Each message that DDEWatch
displays consists of decoded bit fields,
command/data strings and atom names DDE
also supports file logging, allowing DDE
conversations to be captured and written
to a file.

DDELib

DDELib offers Windows programmers an API
that significantly reduces the effort
required to write fully functional DDE
compliant applications. Client and
server demonstration programs are
included.

Table Update

Table update is an end-user Windows
front end for the Microsoft SQL Server
and Gupta's SQLBase. It facilitates
data entry into a set of hierarchically
related tables. Table update is
dynamically driven by the database
schema, including primary and foreign
keys, so no programming is involved.
Table update features a Basic style
macro language, ad-hoc table queries,
Dynamic Data Exchange, Multiple Document
Interface and on-line help facilitie
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Use SnagIt to capture a window and
import it into your favorite Windows
word processor or desktop publishing
progra
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